Some Dentrix and Dexis Basics to Help You With Your Case Study!

Made for the Parkland College Dental Hygiene Department
SCREENSHOTS!
What is a “screenshot”?

• A screenshot is an image taken by the computer user to record the visible items displayed on the monitor.
• Let me take a screen shot of my current computer screen to show you what I mean.
Below is a screenshot of the slide you just saw. The method of taking a screenshot can vary from computer to computer, but it is usually accomplished by hitting the “print screen” button on the keyboard. This button is often abbreviated to show the letters “prt sc” and with some computers you must hit “control” of another button first.

What is a “screenshot?”

• A screenshot is an image taken by the computer user to record the visible items displayed on the monitor.
• Let me take a screen shot of my current computer screen to show you what I mean.
Once you have taken the screenshot, you can either hit the “paste” button under the home tab at the top of the PowerPoint window, or you can simply hit “ctrl” + “v” on the keyboard. The screenshot will then be inserted, and it will be large. See the screenshot below to see what I mean. You will notice that when inserted, the screenshot covered the entire slide. You must size it down by selecting it, grabbing a corner, and dragging it towards the center of the picture.
Below is a sized-down screenshot of a previous slide. You will notice that everything I could see on my computer monitor is visible in the screenshot, including the task bar at the bottom, and all of the PowerPoint options. Perhaps I don’t want you to see all of the extra stuff. Perhaps I just want you to see the slide. In that case, we will crop the screenshot.

What is a “screenshot?”

- A screenshot is an image taken by the computer user to record the visible items displayed on the monitor.
- Let me take a screen shot of my current computer screen to show you what I mean.
In order to crop the screenshot, you must first insert the screenshot as before. Once it is inserted into the powerpoint, you will select it. Once you have selected it, go to the “Format” tab at the top of the screen, and select crop. You will then see little black handles in spots around the screenshot. Click and move those to crop sections off of the image.
Once you crop your screenshot to show only what you want, you will have something like this.

**What is a “screenshot?”**

- A screenshot is an image taken by the computer user to record the visible items displayed on the monitor.
- Let me take a screen shot of my current computer screen to show you what I mean.
The circled screenshots have been captured, pasted, and then cropped in order to appear as they do here. Please note that each entire picture on this slide is also a screenshot.
When to use a screenshot

- Inserting the patient’s teeth and perio charts into the powerpoint (previous slide)
- If using the Dentrix comparison charts to show changes in probing status (see below)
- Showing the Dentrix treatment plan (see below)
When NOT to use a screenshot

• Taking patient photos (from intra-oral camera) from Dentrix/Dexis
• Taking x-rays from Dentrix/Dexis

• If you use screenshots to put these into Powerpoint, they will come out blurry due to the fact that you will have to enlarge them so much after cropping. There is a better way to put these items into a PowerPoint.
THE ART OF EXPORTING IMAGES!
What is “exporting?”

- Exporting is generally converting a file from its current form to another, and often saving it to another location.

- Exporting images (both x-rays and intra-oral photographs) from Dentrix/Dexis allows you to save the picture as a file to the computer. From there, you can insert it into your PowerPoint like you would any other picture. The picture will be large, clear, and not require cropping.
To export an x-ray image from Dexis, go into the Dexis window where you usually view the x-rays. Look for the export button (third from the right on the left side of the upper toolbar, see below). If you hover the mouse over it, it will tell you that it’s the export button. CLICK the export button.
Once you click the export button, a box will come up. There are three buttons you want to click BEFORE you choose to export the images. You want to click “Desktop” at the top to export the pictures to the Desktop. Click “Export All” to include all of the images. Click “JPEG (.JPG)” to export the files in JPEG format. Once you have selected these options, click “Export Images” at the bottom of the box.
The images will now appear on the computers Desktop. The icon looks like the x-ray image.
You can now copy them directly from the Desktop where you see them, or from the actual folder. To go to the folder, click the start button, and then click “Computer.”
Navigate to the Desktop folder. It can often be found as one of the shortcuts on the left-hand side of the box. Click on “Desktop” to go into the folder. Once in the folder, you can copy the pictures to put them on a flash drive, insert them into a PowerPoint or Word document, email them, etc.
Remember, you can also just highlight the images on the Desktop screen and copy them as well.
In order to insert the images to your existing PowerPoint from a flashdrive or other folder on your computer, follow these steps. Go in to the PowerPoint presentation, and go to the “insert tab” at the top. Click “Picture,” and a file window will come up. Navigate to the file folder where the images were saved (could be the desktop if this is the computer on which you exported the images). At this point, you should see the images like in the screenshot below. Select the one(s) you want to insert and click “insert” at the bottom of the box. You can now crop, re-size, and otherwise edit the picture to the way you want.
Look at the images below. The one on the left was inserted as a screenshot, and cropped down to size. The one on the right was exported properly and inserted from an image file. They are both acceptable looking. The export used ClearVu which helps us see more detail, and it can also be enlarged without becoming too blurry. The quality difference is more apparent when working with images from the intra-oral camera, so it is highly recommended that you export those. Also, even though both of these images look okay, keep in mind that the one which was exported did not have to be cropped, saving a big step.
MAKING COMPARISON CHARTS IN DENTRIX
To make an “Exam Comparison,” go into the perio chart. Go to “view” at the top, and then select “Exam Comparison.”
A box will appear, and from that you can check boxes for exams you want to include.
The comparison chart will appear. In order for it to appear as it does below, make sure that “Clinical Attachment Level – Graphic” is selected from the drop down box.

Note: If you don’t see the drop box, look for the “show options” button. In this image, the button say “hide options” because the options are shown.
All of the colors used in the comparison chart can be changed. Click on the “Perio Display...” button in the bottom left corner of the chart. A box will pop up. Click on the “Exam Comparison Colors” tab. You will now have the option to change all of the colors used to make your chart more readable, or to make it match your PowerPoint presentation theme.
You can make a different kind of comparison by simply selecting a different option from the previously shown dropdown box. This option is the “Probing Depths – Data” option.

Notice the arrows which depict pocket depth increases and decreases between exams. You will only see these when you compare two exams (not if you compare more than two).
If you need to open a previous perio exam simply to see the probe reading, go to “File” at the top of the Perio window, and select “Open Exam.”
If you only need the most recent exam, it is already displayed when you open the Perio window. However, if this most recent exam was not just performed, the numbers will be faded looking rather than bright like they were when the readings were recorded. If you go to “Open Exam” and select the exam date, it will make the readings bright again.
What is an exam you want to include in your presentation is not on the computer? If you have perio exam information for a patient that is charted on paper, you can input the information into the computer chart in order to include it. Go to the Perio window, go to “File” at the top, and select “New Exam” from the drop down options.
A calendar box will pop up. Use the arrows to select the date that the exam was performed (make sure you are in the correct year).
Another good and quick visualization you can utilize is made by simple clicking one button in the Perio window. Click the “Graphic Chart” button on the toolbar. If you are having trouble telling which button is the correct one, hover the mouse over a button and it will tell you which button it is.
Here is an example of the chart that will be displayed if you use the “Graphic Chart” button. Note: You can also get this by going to the “View” tab and selecting “Graphic Chart.”
At the bottom of the box in which the graphic chart is displayed, you can select “Show Options” and then choose various things to include (furcations, bleeding, CAL level, etc.)
There is also an “Exam Comparison” button which will allow you to produce the previously shown comparisons (as opposed to going through the “View” tab at the top.)
MAKING A TREATMENT PLAN
Making a treatment plan is a great thing to do because it shows our patients an estimate of how much they would have to pay for the work we are giving them if they were to go to a normal practice (assuming they do not have insurance). This helps them appreciate the services we offer, even if appointments are long and deep scalings aren’t fun. To begin, click the “Treatment Plan” button at the top of the main dental chart window.

Note: Insure that the light switch button is also selected.
Use the “Procedure Codes” box on the right side of the screen to select the procedures you wish to include in the treatment plan. Once you select a procedure (or multiple procedures at once), click the tooth with the checkmark to add them to the plan.
Once all of the codes you want have been added, go to the “Options” tab at the top, and select “Treatment Planner.”
This is what you will see. The codes you selected should be shown.

<table>
<thead>
<tr>
<th>Code</th>
<th>Description</th>
<th>Fee</th>
<th>Patient Portion</th>
</tr>
</thead>
<tbody>
<tr>
<td>D1110</td>
<td>Prophylaxis-adult</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>D1206</td>
<td>Topical fluoride</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>D1330</td>
<td>Oral hygiene</td>
<td>0.00</td>
<td>0.00</td>
</tr>
</tbody>
</table>

The treatment plan case total is $0.00, the estimated deductible applied is $0.00, and the estimated insurance payment is $0.00. The estimated guarantor portion is also $0.00.
In order to print an appealing, patient-friendly version of the treatment plan, go to “File,” “Print,” and then click “Print Treatment Case.”
This box will come up. It is very important to go through the options and select or deselect the appropriate ones. Check the “Print Preview” box at the bottom so that you can review it before printing. This will allow you to make sure no information is included that shouldn’t be.

Some important options are circled here.

**SELECT** “Compare to Fee schedule:”

**Deselect** “Graphic Chart,” “Patient Education,” and “Use Cover Page.”

Under “Header Style:” select “Provider Name” as opposed to clinician name so that your name is not displayed on the print out.
Once you click “OK,” the print preview will come up. If you are satisfied, click print and give it to your patient. Also, if you are doing this for a case study and have a moment, take this opportunity to take a screenshot of the treatment plan and save it for your presentation.
GOOD LUCK WITH YOUR CASE STUDY!
EXAMPLE SLIDES FROM A CASE STUDY
<table>
<thead>
<tr>
<th></th>
<th>F</th>
<th>PD</th>
<th>GM</th>
<th>CAL</th>
<th>MGJ</th>
<th>FG</th>
<th>Bld</th>
<th>Sup</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>3</td>
<td>3</td>
<td>3</td>
<td>4</td>
<td>3</td>
<td>3</td>
<td>3</td>
<td>3</td>
</tr>
<tr>
<td>PD</td>
<td>3</td>
<td>3</td>
<td>7</td>
<td>3</td>
<td>7</td>
<td>3</td>
<td>3</td>
<td>4</td>
</tr>
<tr>
<td>GM</td>
<td>3</td>
<td>3</td>
<td>7</td>
<td>3</td>
<td>7</td>
<td>3</td>
<td>3</td>
<td>4</td>
</tr>
<tr>
<td>CAL</td>
<td>3</td>
<td>3</td>
<td>7</td>
<td>3</td>
<td>7</td>
<td>3</td>
<td>3</td>
<td>4</td>
</tr>
<tr>
<td>MGJ</td>
<td>3</td>
<td>3</td>
<td>7</td>
<td>3</td>
<td>7</td>
<td>3</td>
<td>3</td>
<td>4</td>
</tr>
<tr>
<td>Bld</td>
<td>3</td>
<td>3</td>
<td>7</td>
<td>3</td>
<td>7</td>
<td>3</td>
<td>3</td>
<td>4</td>
</tr>
<tr>
<td>Sup</td>
<td>3</td>
<td>3</td>
<td>7</td>
<td>3</td>
<td>7</td>
<td>3</td>
<td>3</td>
<td>4</td>
</tr>
</tbody>
</table>

**Bleeding points = 7**

**PD >3 = 31**
Bitewings
# Treatment Plan

<table>
<thead>
<tr>
<th>DATE</th>
<th>VISIT</th>
<th>TH</th>
<th>SURF</th>
<th>CODE</th>
<th>PROV</th>
<th>DESCRIPTION</th>
<th>FEE</th>
<th>PAT</th>
<th>PRI INS</th>
<th>SEC INS</th>
<th>FEE 4</th>
</tr>
</thead>
<tbody>
<tr>
<td>07/02/2013</td>
<td>0</td>
<td></td>
<td></td>
<td>D0120</td>
<td>P059</td>
<td>Periodic oral evaluation</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>42.00</td>
</tr>
<tr>
<td>07/02/2013</td>
<td>0</td>
<td></td>
<td></td>
<td>D0210</td>
<td>P059</td>
<td>Intraoral-complete series (bw)</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>115.00</td>
</tr>
<tr>
<td>07/02/2013</td>
<td>0</td>
<td></td>
<td></td>
<td>D0350</td>
<td>P059</td>
<td>Oral/Facial Photographic Images</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>07/02/2013</td>
<td>0</td>
<td></td>
<td></td>
<td>D1110</td>
<td>P059</td>
<td>Prophylaxis-adult</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>77.00</td>
</tr>
<tr>
<td>07/02/2013</td>
<td>0</td>
<td></td>
<td></td>
<td>D1206</td>
<td>P059</td>
<td>Topical fluoride varnish</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>35.00</td>
</tr>
<tr>
<td>07/02/2013</td>
<td>0</td>
<td></td>
<td></td>
<td>D1330</td>
<td>P059</td>
<td>Oral hygiene instruction</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>15.00</td>
</tr>
</tbody>
</table>

**Totals:**

- Fee: 0.00
- Pat: 0.00
- Pri Ins: 0.00
- Sec Ins: 0.00
- Total: 284.00
### Massive Improvement!

<table>
<thead>
<tr>
<th></th>
<th>6</th>
<th>7</th>
<th>8</th>
<th>9</th>
<th>10</th>
<th>11</th>
</tr>
</thead>
<tbody>
<tr>
<td>DCM</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1&lt;sup&gt;st&lt;/sup&gt; appt.</td>
<td>3</td>
<td>2</td>
<td>3</td>
<td>4</td>
<td>3</td>
<td>4</td>
</tr>
<tr>
<td></td>
<td>▲</td>
<td>▲</td>
<td>▲</td>
<td>▲</td>
<td>▲</td>
<td>▲</td>
</tr>
<tr>
<td>2&lt;sup&gt;nd&lt;/sup&gt; appt.</td>
<td>2</td>
<td>2</td>
<td>2</td>
<td>2</td>
<td>2</td>
<td>2</td>
</tr>
<tr>
<td></td>
<td>▲</td>
<td>▲</td>
<td>▲</td>
<td>▲</td>
<td>▲</td>
<td>▲</td>
</tr>
<tr>
<td>1&lt;sup&gt;st&lt;/sup&gt; appt.</td>
<td>3</td>
<td>2</td>
<td>2</td>
<td>2</td>
<td>2</td>
<td>2</td>
</tr>
<tr>
<td></td>
<td>▲</td>
<td>▲</td>
<td>▲</td>
<td>▲</td>
<td>▲</td>
<td>▲</td>
</tr>
<tr>
<td>2&lt;sup&gt;nd&lt;/sup&gt; appt.</td>
<td>2</td>
<td>2</td>
<td>2</td>
<td>2</td>
<td>2</td>
<td>2</td>
</tr>
<tr>
<td></td>
<td>▲</td>
<td>▲</td>
<td>▲</td>
<td>▲</td>
<td>▲</td>
<td>▲</td>
</tr>
</tbody>
</table>